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1 WELCOME TO PIXELSTYLE PHOTO 

EDITOR

PixelStyle  Photo  Editor  is  an all-in-one Mac Photo Editor  with  a huge range of  high-end filters:

lighting,  blurs,  distortions,  tilt-shift,  shadows, glows and so forth.  PixelStyle Photo Editor  for  Mac

endows  full-featured  graphic  design  tools  and  powerful  image  editing  tools  for  all  professional

photographers and hobbyists.

With this tutorial,  we will  show you how to edit  your photos and design graphics on Mac  using

PixelStyle Photo Editor. The latest  Mac version can be found on the product page and you may

download for trial.
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GETTING STARTED - NEW USERS 
1. See Install and Uninstall to know how to quickly install and easily uninstall your copy of PixelStyle

Photo Editor. 

2. See Registration to know how to register for full version.

3. See Quickly Start Tutorial to quickly start your new experience in PixelStyle Photo Editor.

GETTING STARTED - OLD USERS
1. See Frequent Asked Questions to find solutions or answers to your questions.

2.See Tips to acquire more neat tricks on how to get the most out of PixelStyle Photo Editor.
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2 INTRODUCTION
This chapter gives a brief introduction to the features, advantages and update history of PixelStyle 

Photo Editor.

HOW TO GET STARTED
1. See Registration to know how to register for full version.

2. See Quickly Start Tutorial to quickly start your new experience in PixelStyle Photo Editor.

LEARNING MORE
1. See Frequent Asked Questions to find solutions or answers to your questions.

2. See Tips to acquire more neat tricks on how to get the most out of PixelStyle Photo Editor.

3. See Work Area Overview to familiar with the interface of PixelStyle Photo Editor.
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2.1 WHY CHOOSE PIXELSTYLE PHOTO EDITOR

1. Easier: Including all the essential tools needed for basic and professional photo editing, PixelStyle

Photo Editor is designed easy for both novice and professionals. You will find all tools at your hand

and start your work in five to ten minutes after first try.

2. Faster and smoother:  Taking full advantages of the latest OS X technologies and unique smart

processing engine,  PixelStyle Photo Editor occupies less disk and memory space, also runs faster

and smoother. 

3.  More  inspiring: PixelStyle  includes more  than 100 exquisite  drawing brushes for  oil  painting,

sketch, texture painting and more to bring your creativity into full play.

4. Best-in-class Photo Noise Reduction: Reduces low light and high ISO noise.

5. Comprehensive RAW Editing: Smart RAW processing engine.

6. Handy Geometric Drawing and Editing:  PixelStyle supports a variety of geometric drawing tools,

such as: straight lines, rectangles, circles, ellipses, polygons, stars, clockwise spiral and much more.
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2.2 UPDATE HISTORY

V3.5.1 (11/10/2016)
1.App stability improvement.

V3.3.5 (10/11/2016)
1.Optimized for MacOS Sierra.

2.Optimization of free vector transform function.

3.Automatically select layer(s).

4.Auto-reduction of displaying images once opened.

5.Automatically enter transformation mode after dragging or importing images.

6.Enable moving layer(s) directly once the transformation is set.

7.The app has been localized to Chinese.

V3.3.2 (09/22/2016)
1.Drag and drop an image to PixelStyle from a web browser.

2.Drawing anywhere beyond the original size of the layer.

3.Keep aspect ratio while making scale transform.

4.Adding eight direction cursors for the rotation transform tool.

5.Soft the check board image for background.

6.Can now click a tool item directly after clicking a group of tool items.

7.Improve the robust of the rendering engine.

8.Remove a crash bug for the shape tool.

9.Remove a bug for clicking to show layer or hide.

V3.3.0 (09/16/2016)
1.Support Chinese version.

V3.2.0 (09/12/2016)
1.Deleting points is allowed when drawing with the pen tool.

2.A layer can be filled with transparent color.

3.Fix a bug that the name of text layer is displayed falsely.

4.The angle can be changed when shapes are filled with gradient colors.

5.The background auto save feature is available.

6.More shortcuts are supported.

7.Many minor bugs are fixed.

8



V3.0.5 (06/06/2016)
1.Optimize the display of cursors.

2.Add some shortcuts.

3.Remove some bugs.

V2.9.5 (05/25/2016)
1.Several  effects of  ‘fx’ layer style support multi-color  processing with a variety of style including

linear, radial, burst, etc.

2.Replace the area that is cut with transparent color.

3.Replace the erased area with transparent color.

4.Fix a bug where the function of undo can not work when using the eraser tool.

5.Fix a problem where the selection doesn’t change following the image when using the transform

tool.

6.Fix a bug that the revert can’t work correctly sometimes.

7.Fix a bug when the app starts.

8.Fix a problem when you apply the amazing effect to the current layer directly.

9.Fix other minor bugs.

V2.9.2 (05/10/2016)
1.Automatic alignment mechanism: moving the layer up and down close to other layers or image

canvas edge, the layers align automatically.

2.You can now drag and drop images from other documents into PixelStyle's current document.

3.When you are moving the layers, the selections will move as well.

4.Fixed a bug where the tool could not be selected directly after you have done some transform for

the selected layers.

5.Fixed a problem where selections weren't scaled correctly sometimes.

6.Fixed a bug where the channel can't work correctly sometimes.

7.Fixed a problem when you switch back from the channel view.

8.Fixed a problem where you can’t redraw a selection in the add/subtract mode.

9.Fix some other small bugs.

V2.9.0 (04/29/2016)
1.Converting Text into Bézier Shapes: You can modify the text with the anchor points and control

handles.

2.Sumdge tool: the tool is used to smear paint. It takes a color from where you start clicking and

smears it into other colors of your image as you drag your cursor. This is useful for removing flaws

from photos.

3.Burn tool: darkens pixels where you paint. This is great if you want to darken certain areas of your

image. The tool has an exposure option which controls how intense the effect is.
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4.Dodge tool: lightens pixels where you paint. The dodge tool works in the same way as the burn

tool, only it lightens the pixels, rather than darkens them.

5.Sponge tool: saturates or desaturates the pixels where you paint. You can use the tool to paint in

localized adjustments that will modify the saturation of an image. It has two modes: desaturate and

saturate. Desaturate mode dulls the colors, turning them gray. Saturate mode intensifies the color,

making them brighter. The pressure option controls how strong the effect is applied.

V2.8.0 (04/25/2016)
1.Copy the selected shapes.

2.Red eye remove tool: reduce the effect of red eye caused by your camera flash.

3.Basic SVG support! You can now import SVG files.

4.Beautify the UI of toolbar.

5.Fix some other small bugs.

V2.7.0 (04/12/2016)
1.Add anchor points: add more points to the shapes.

2.Delete anchor points.

3.Reset control Points: Click curve point to change to corner point, Click converts back to curve point.

4.Beautify the UI of toolbar.

5.fix a problem in copying the text layer.

6.Fix a bug where the text distortion effects disappear when you open the project file.

7.Fix a potential crasher when use the brush tool after rasterizing the vector layers.

8.Fix some other small bugs.

V2.6.0 (04/05/2016)
1.Pen tool: the pen tool is a shape tool used to create vector shapes by clicking.

2.Freeform pen tool: the tool is a shape tool used to create custom vector shapes. The path is not

closed.

3.Closed freeform pen tool: create custom closed vector shapes.

4.Path eraser tool: eraser the vector shapes.

5.Basic SVG support! You can now export documents and shape layers as simple SVG files. SGA:

This is a pure vector export- any bitmap operations like layer filters or masks are ignored for SVG

export.

6.Do some transform for selected shapes.

7.Fix a bug in transforming the vector layers after the layers moved.

8.Fix some other small bugs.

V2.5.0 (03/28/2016)
1.Smart Filters:

1.1 Flatten Image: You can apply the amazing effect to the current layer directly.
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1.2 Beautify the UI of smart filters.

1.3 Add more filters.

2.Vector tool:

2.1  Apply  transformations  to  the  vector  layer, such  as  rotate, scale, skew  and  perspective

transformation of the entire layer.

2.2 You can change the mode for the selected path. It provides multiple interactions: unite paths,

intersect paths, subtract from paths, exclude paths and much more.

2.3 Choose one or more shapes, then you can do some action for them together.

2.4 Adjust the setting for the selected shapes.

2.5 Drag the selected shapes.

2.6 Align the selected shapes.

2.7 Arrange the selected shapes.

2.8 Draw multiple shapes in a layer.

3.Fixed a bug that the displayed image scaling factor is different from the actual scale.

4.Fixed a bug that the position of vector sharps will go wrong after the vector layer has been moved.

5.Automatically update the thumbnail when users have finished drawing the shapes.

6.Fixed a potential crash when refreshing.

V2.4.0 (03/14/2016)
1.Smart Filters:

Add some powerful smart filters, which contains hue, saturation, brightness, contrast adjustment and

much more. All of these filters are non-destructive and easy to use. Merge layer styles and smart

filters into one beautiful UI so as to create more amazing effects. You can always change your mind

later on.

2.Fix a bug where the undo action would not work correctly after you had done some redo actions.

3.Fix a bug in saving layer settings.

4.Fix a problem where the rectangle selection tool would not work correctly in new selection mode.

5.Fix a potential crash when being scaled quickly.

V2.3.0 (03/07/2016)
1.Geometric drawing tools.

Supports a variety of geometric drawing tools, such as: straight lines, rectangles, circles, ellipses,

polygons, stars, clockwise  spiral  and much more. Some of  these shapes can be adjusted. The

default setting is vector drawing, which can be converted to raster. Each geometric tool will support

fill, stroke, lights effect settings. What's more, you can also change the settings of line type.

2.Fix a potential crasher when click the inverse item of the select menu after having done the select

all action.

3.Fix a bug where the transform tool would not rotate correctly.

4.Fix an issue where the rectangle selection tool would sometimes copy the current layer.

5.Fix some other small bugs.
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V2.2.5 (02/29/2016)
1.Add the link to enter the PixelStyle easily.

2.Add the function of checking/prompting the Latest version.

3.Remove some bugs.

V2.2.0 (01/27/2016) (First release)
1.Professional Image Processing for Mac.

2.Top Mac Drawing Tools.

3.Powerful Layer Capabilities on Mac.

4.Excellent Mac Font Design Tool.

5.Designed exclusively for Mac.

2.3 ABOUT THE TRIAL
19.1MB in size, the trial version is a shareware that has a limitation on exporting your works. Get the

trial version here.

Go our official website to get full version now!

2.4 SUPPORTED LANGUAGES
English, Simplified Chinese, Traditional Chinese.
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3 INSTALL AND UNINSTALL 

This section guides you to quickly install, Register and Uninstall your copy of PixelStyle Photo Editor. 

Please note:

Before installation, you may turn to System Requirements to see whether this App can be compatible

with your Mac system;

Quickly install PixelStyle Photo Editor on your Mac by following the guides for installation;

According to uninstall guides, you may easily delete your copy of PixelStyle Photo Editor in your

computer.

RELATED TOPICS
Insroduction

Why Choose Pixelstyle Photo Editor

Registration
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3.1 SYSTEM REQUIREMENTS

Applicable  system:  OS  X  10.8,  10.9,  10.10,  10.11,  10.12,  iMac,  MacBook  Mini,  MacBook  Air,

MacBook Pro, Yosemite, Mavericks, EI Capitan, MacOS Sierra.

RELATED TOPICS

Iinsroduction

How To Install

How To Uninstall

Quick Start Tutorials
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3.2 HOW TO INSTALL

The latest version is available here.

Step 1. To install PixelStyle Photo Editor, double-click the disk image.

If it doesn’t open automatically, right-click to open it, then follow the onscreen instructions.

15

http://www.effectmatrix.com/mac-appstore/download/PixelStyle-Photo-Editor-Mac.dmg


Step 2. Drag and drop to install.

If  you  get  a  warning  dialog  about  installing  an  app  from  an  unidentified  developer,  it  doesn’t

necessarily mean that something’s wrong with the app. Maybe it was written before developer ID

registration  began  or  has  not  been  reviewed  by  Apple.  Anyway,  we  ensure  100%  security  of

PixelStyle Photo Editor.

To open in a safe approach:

1. In the Finder, locate the app you want to open.

Don’t use Launchpad to do this. Launchpad doesn’t allow you to access the shortcut menu.

2. Press the Control key, then click the app icon, then choose Open from the shortcut menu.

3. Click Open.

PixelStyle Photo Editor is saved as an exception to your security settings, and you can open it in the 

future by double-clicking it just as you can any other app.

RELATED TOPICS
Insroduction

Why Choose Pixelstyle Photo Editor

Quick Start Tutorials
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3.3 HOW TO UNINSTALL

Click the Launchpad icon in the Dock, hold down PixelStyle Photo Editor’s icon until all the icons

begin to jiggle, then click its delete button  . If an icon doesn’t have a delete button, it can’t be

uninstalled in Launchpad.

Try  another  way  to  uninstall:  In  the  Finder  sidebar,  click  Applications.  Drag the  app  from  the

Applications folder to the Trash (located at the end of the Dock), then choose Finder > Empty Trash.

If you change your mind before emptying the Trash, select the app in the Trash, then choose File >

Put Back.

WARNING: When you empty the Trash, the app is permanently removed from your Mac. If you have

any files that you created with the app, you may not be able to open them.

If you later want the app, you can reinstall it from the product page. 

RELATED TOPICS

Insroduction

Registration

How To Install

Quick Start Tutorials
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4 REGISTRATION

Once you get a registration code for PixelStyle Photo Editor, you may copy and paste the code to the

registering window to register after installation:

Enter your name or create a new name to register the program.
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5 FUNCTION SUMMARY

This chapter offers you an overview of PixelStyle’s functions, tools, unique features and supported

languages for you to see what you can do with PixelStyle Photo Editor.

RELATED TOPICS
Insroduction

Why Choose PixelStyle Photo Editor

Unique Features

Work Area Overview
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5.1 MAIN FUNCTIONS
1. Easily Resize Images
PixelStyle gives you sufficient options to easily resize your images by width and height with or without

keeping aspect ratio to fit screen, clipboard or paper size.

2. Apply Dazzling Filters
Apply nearly 50 dazzling filters to your images to achieve particular effects: blur, distort, exposure,

sharpen, noise reduction, halftone effects…

3. Add Unlimited Layers
PixelStyle has powerful layer capabilities that support unlimited layers and layer groups for you to

freely create, duplicate and delete layers – the only limit  is your computer’s parameters. Placing

layers or automatic adding new layers from Finder and browsers are never laggard with hundreds of

layers.

4. Flexibly Adjust Layers
With ‘Layer’ command in the Menu Bar, you are allowed to make precision adjustment of layers.

Combined with other tools, you can resize, scale, rotate, skew, trim, condense, expand layers and

adjust layer boundaries.

5. Add layer effects
Easily add one or stacked non-destructive layer effects like shadows, fills, inner glow, outer glow, or

strokes.

6. Retouch Photos
As a professional photo editor for Mac, PixelStyle has all the essential tools and unique feature to

touch up your photos: color and style adjustments, 50 high-end filters, various layer effects and blend

modes, which helps you remove red eye, erase unwanted pixels, lighten and darken a certain area,

smudge color on an active layer, heal and repair Images, create retro style effect…

7. Edit Texts
Quickly and easily place your text  on a half-circle to create logos and other useful  text designs.

Modify your text with a full set of advanced typography features like kerning, bold, italic, underline,

line-through.

8. Crop Images
Select certain aspect ration to accurately cut out the portion you want. Live Information Panel is for

your reference to view its width, height and RGBA value of cursor.
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9. Sample Color
Use Eyedropper Tool to sample a pixel or a group of pixels as foreground color or background color.

You can set to grab color from just the current layers or from all visible layers or from the background.

10. Select Pixels in an Image
PixelStyle adopts advanced algorithm in selecting a specific color range in an image. You can create,

add, subtract, intersect, invert selections and set to soften the edge of selections.

11. Flatten Images
Merge or flatten selected or all layers into one after finishing editing all the layers in your image to

reduce the file size.

12. Switch Blend Mode Live
Nearly 30 blend modes of different opacity are available for you to achieve unexpected and special

effects when working with layers, painting, retouching and fill tools. 

13. 4-Channel Editing
Editing of individual channel, including red, green, blue, alpha channel, is supported in PixelStyle to

bring you great convenience in determining background transparency and color of a layer.  

14. RAW Editing
PixelStyle endows powerful engine and smart algorithm that comprehensively support Raw editing.

15. Geometric Drawing and Editing
PixelStyle supports a variety of geometric drawing tools, such as: straight lines, rectangles, circles,

ellipses, polygons, stars, clockwise spiral and much more. All of these shapes can be adjusted, like

move, scale, skew and rotate. The default setting is vector drawing, which can be converted to raster.

Each geometric tool will support fill, stroke, lights effect settings. What's more, you can also change

the settings of line type.

16. Creative drawing
PixelStyle includes more than 100 built-in drawing brushes (pencil, airbrush, watercolor brush, chalk,

charcoal,  neon  pens...)  for  oil  painting,  sketch,  texture  painting,  etc.  Exquisite  brushwork  with

customized settings are awaiting you to bring your creativity into full play.

17. Create a Gradual Color Shift
With 8 styles of gradient and 2 repeating patterns, Gradient Tool allows you to create a shift from

foreground color to background color of different opacity for a wide range of effects.
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18. Fill Objects with Color or Texture
Flood an area or all selected areas of similar color with a single color or texture with live preview.

Apart from nearly 60 types of texture, PixelStyle allows to export any selected images as texture.

RELATED TOPICS
Introduction

Why Choose PixelStyle Photo Editor

Work Area Overview

Frequently Asked Questions
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5.2 NEW FUNCTIONS

1. Directly Drag Images from a Webpage
Directly drag images from Safari, Google Chrome, other browsers, or other documents and drop to

the Document Window. PixelStyle will automatically add a new layer for one image.

2. Support Vector Transformation
Export your vector art to PixelStyle. It helps you to edit and transform with its unique features like

path selection, node editor, path eraser and so forth. Finally export to SVG without any loss.

3. Smartly Select Layers
Click on any part of the Document Screen, it will instantly activate the corresponding layer where the

image, shape or texts base, which enables faster editing. 

4. Automatically Adjust Newly-Added Images to Canvas 
PixelStyle is designed to take every detail into consideration. It will give you options whether to adjust

newly-added images to canvas, which is useful when you want to set a uniform standard for image

size.

5. Export to SVG
Support export to  TIFF, JPEG, PNG, GIF, BMP, PSDB, JPEG 2000, PDF, SVG. You may save as

PSDB to edit them next time.

6. Align Layers Automatically
Automatic alignment mechanism is newly built. When you move the layer up and down close to other

layers or image canvas edge, the layers align automatically.
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5.3 TOOLS

PixelStyle Photo Editor provides you a wide range of tools enabling you to select, paint, retouch,

draw, transform, move, align, crop, sample color, add text and manipulate.

As the most significant panel in PixelStyle, Tools Panel gives you full solutions to edit images and

design graphics. Each tool is meticulously designed to bring out your best experience in designing

and creating your works.

To use a tool:
Click the tool icon in the Tools panel.

Please note:
When you put cursor on a tool, it will be convex with lighter color; when you click a tool icon, it will be

concave with darker color to let you know which tool is active. 

Tools Shortcut Description
Basic Tools

Move and Align Tool V Used to move and align layers in different manner.

Zoom Tool Z Used to magnify and reduce the view of an image.

Transform Tool Command-T Used to scale, rotate, skew layers.

Eyedropper Tool R Used to sample colors on an image.

Crop Tool C Used to trim images.

Text Tool T Used to add texts to layers.

Selection Tools

Rectangular Marquee Tool M Used to make rectangular selections.

Elliptical Marquee Tool M Used to make elliptical selections.

Lasso Tool L Used to make freehand selections.

Polygonal Lasso Tool L Used to make straight-edged selections.

Magic Wand Tool W Used to select area of the same color.

Painting Tools

Art Brush Tool B Used to create stylized strokes.

Brush Tool B Used to paint brush strokes.

Pencil Tool B Used to paint sharp-edged strokes.

Retouching Tools

Eraser Tool E Used to erase parts of images.

Smudge Tool O Used to smear an area of an image.
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Clone Stamp Tool S Used to paint with a sample of an image.

Red Eye Remove Tool R Used to remove red eyes.

Burn Tool O Used to darken certain areas.

Dodge Tool O Used to lighten certain areas.

Sponge Tool O Used to saturate or desaturate certain areas.

Paint Bucket Tool G Used to fill in areas with colors or textures.

Gradient Tool G Used to create a shift from foreground color to 

background color.Shape Tools U

Line Shape Used to draw lines.

Rectangular Shape Used to draw rectangular shapes.

Ellipse Shape Used to draw ellipses.

Star Shape Used to draw star shapes.

Polygon Shape Used to draw polygons.

Clockwise Spiral Used to draw clockwise spiral.

Vector Tools

Pen Tool P Used to create vector shapes.

Freeform Pen Tool Used to create customized vector shapes.

Closed Freeform Pen Tool Used to create customized vector shapes with 

closed path.Path Selection Tool A Used to select and move vector shapes.

Path Eraser Tool E Used to erase path of vector shapes.

Node Editor Tool N Used to edit nodes of vector shapes.

25



5.4 UNIQUE FEATURES

1. A set of high-end Filters
A set of high-end filters (lighting, blurs, distortions,  sharpening, tilt-shift, glows...) to create unique,

inspiring artistic works. With PixelStyle’s filter panel, adding effects to your images has never been so

easy.

2. Professional Photo Adjustments
Adjust exposure, hue, vibrance, white balance, shadows, highlights, brightness, contrast, blackpoint,

clarity and much more to expertly make your images look spectacular.

3. Photo Retouching and Correction
Enjoy  a  simple  and  elegant  collection  of  full-featured  intuitive,  professional  retouching  tools  of

PixelStyle to quickly delete unwanted objects and retouch photos so they look absolute best.

4. Best-in-class Photo Noise Reduction
Use PixelStyle’s best-in-class photo noise reduction technology to reduces low light and high ISO

noise, and see the result in real time. 

5. Comprehensive RAW Editing
PixelStyle  endows  powerful  RAW  processing engine  and  smart  algorithm  that  comprehensively

support Raw editing.

6. Unsurpassed Drawing Tools
More than 100 built-in drawing brushes (pencil,  airbrush, watercolor brush, chalk, charcoal,  neon

pens...) for oil painting, sketch, texture painting. You can create custom brushes and use different

brush sizes, shapes, hardness, and blending modes.

7. Powerful Layer Capabilities
Full  support  for  unlimited  layers  and  layer  groups.  Easily  add  non-destructive  layer  effects  like

shadows, fills, inner glow, outer glow, or strokes. Support over 50 different filter effects and blending

mode options along with channel selection and Alpha channel editing features.

8. Excellent Text Design Tools
With PixelStyle’ text tool, you can quickly and easily place your text on a half-circle to create logos

and other useful text designs with text layer effects like shadows, strokes, inner glow, outer glow, or

fills. Convert type layers into raster layers and enjoy a full set of advanced typography features like

kerning, bold, italic, underline, line-through and much more.
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9. Designed Exclusively for Mac
Takes full advantage of the latest OS X technologies including OpenGL, Grand Central Dispatch and

Core  Graphics,  PixelStyle uses the  Touch  trackpad  to  paint  with  pressure  sensitivity  and  fully

optimized for 64-bit and multi-core processors.  Also, support regular, retina and multi-monitor set

ups.

10. Superb Geometric drawing
PixelStyle supports a variety of geometric drawing tools, such as: straight lines, rectangles, circles,

ellipses, polygons, stars, clockwise spiral and much more. All of these shapes can be adjusted, like

move, scale, skew and rotate. The default setting is vector drawing, which can be converted to raster.

Each geometric tool will support fill, stroke, lights effect settings. What's more, you can also change

the settings of line type.
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5.5 SUPPORTED FILE FORMATS

1. Import
PNG, TIFF, JPEG, PNG, GIF, BMP, PSDB, PDF, SVG, JPEG 2000, CR2, NEF and more.

2. Export
TIFF, JPEG, PNG, GIF, BMP, PSDB, JPEG 2000, PDF, SVG.

RELATED TOPICS
Introduction

Why Choose PixelStyle Photo Editor

Frequently Asked Questions

Tips

28



6 QUICK START TUTORIALS

This Chapter guides you to quickly start your work with PixelStyle Photo editor for Mac. You are able

to know how to create a new document, make selections, paint, draw shapes, add text, save or

export you work, as well as resizing, retouching, transforming your images. 

RELATED TOPICS

Introduction

Why Choose PixelStyle Photo Editor

How to Install

Unique Features

Frequently Asked Questions
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6.1 HOW TO CREATE OR OPEN IMAGES?

6.1.1 HOW TO CREATE A NEW IMAGE?
To start working in PixelStyle, first create a new document.

Step 1. Double click to open PixelStyle Photo Editor in Applications or Launchpad or on desktop. 

Step 2. Choose the new document preset, transparency of background or type the width, height, and

resolution for the document when the “New Image” dialog appears. Then click “Create”  to begin

working on the new document.
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PLEASE NOTE: 

1. Choose the measurement units in the “Width” and “Height” drop-down menus to specify an image

width or height in pixels, inches, or centimeters.

2. Four document preset options are Default (1024px * 768px), Clipboard (1024px * 768px), Screen 

size (1366px * 768px) and Paper size (US letter, 6.5in * 8.5in).
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6.1.2 HOW TO OPEN AN IMAGE?

When using PixelStyle, you can open images in different file formats, including PNG,  TIFF, JPEG,

PNG, GIF, BMP, PSDB, PDF, SVG, JPEG 2000, CR2, NEF and more. The following part separately

describes how to open an image as a new document or an addition to current document:

1. To Open an image as a new document, please do one of the following.

(1)Open in “New Image” dialog

Step 1. Double click to open PixelStyle Photo Editor in Applications or Launchpad or on desktop.

Step 2. Click “Open…” to open an image or a recently used document.
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Step 3. Select the file you want to open. Click “Open” or press “Cancel” to quit current action.
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(2)Choose to open with PixelStyle Photo Editor
Press the Control  key, then click  the image. Choose “Open With”  from the shortcut  menu, then

choose “PixelStyle”.

2. To open an image as addition to current document 
A new image has a single layer, and a document can be composed of many layers. To open an

image as addition to current document, PixelStyle provides you several approaches. please do one

of the following:

(1)Import your image
Step 1. Choose File > Import.
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Step 2. Select the file you want to open, then click “Open”.

(2)Drag and drop to open 
Locate your image, then directly drag and drop to the work area of PixelStyle.
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6.2 HOW TO RESIZE IMAGES?
Use the “Resize image” dialog to change to the size you want. 

Step 1. Choose Image in the menu bar, then click Resize Image.

Step 2. In the “Resize image” dialog, type the dimensions for the new image in the width and height

fields. You can also change the percentage of horizontal and vertical length. 
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TIP: 
You can click on the chain icon to modify height-width ratio.

Step 3. Click “Scale”.
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6.3 HOW TO CROP IMAGES?

With PixelStyle’s Crop Tool, you can remove unwanted portions of an image to create focus.

Step 1. Select the “Crop Tool” in the Tools panel.

Step 2. Set the proportions or certain dimensions for the crop marquee.
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TIP: 
The default setting “Normal” means crop image without any constrain.
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Step 3. Drag over the part of the image that you want to keep.

TIP: 
Press Shift to crop with 1:1 proportion.

Step 4. Adjust the crop marquee if necessary.

1.  To move the crop marquee: drag the entire marquee to another position by placing the pointer

inside the bounding box and dragging.

2. Scale the crop marquee by dragging its handles.
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Step 5. Complete the crop.

TIP: 
To discard the crop, click anywhere outside the bounding box and.

To cancel the crop, press Command and Z.
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6.4 HOW TO MAKE FREEHAND SELECTIONS?

Selections can be great help when you want to alter or adjust one specific portion and leave others

unaffected.

Step 1. Select the “Lasso Tool” in the Tools panel.

Step 2. Choose a selection mode in the Options panel.

Lasso Tool has five selection modes available in the Options panel:

A New selection Creates a new selection
B Add to selection Adds a new selection to an existing selection
C Subtract from selection Subtracts from an existing selection
D Intersect with selection Selects the overlap of two selections
E Invert the Intersected selection Subtracts the overlap of two selections
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Step 3. Drag to draw a freehand selection border.

TIP: 
To close the selection, release the mouse.
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Step 4. Refine the selection if necessary.

You are able to move and scale the selection border by eight handles.

The result after adjusting the color:
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6.5 HOW TO PAINT WITH ART BRUSHES?
Select  from hundreds  of  exclusively-designed  brush  types  to  paint  as  realistic  as  you  do  on  a

traditional canvas.

Step 1. In the Tools panel, select the Art Brush Tool to paint soft strokes.

Step 2. Select specific brush tip, stroke, radius and other options.

A – Displays your most often used brush tips and strokes.

B – Select a brush type from brushes, pens, pencils, airbrushes, scrawls and more.
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C – Adjust or type the radius of brush stroke.

D – Adjust or type the opacity of brush stroke.

E – Adjust or type the hardness of brush tip.

F – Adjust or type the smooth of brush stroke.

G – Adjust or type the pressure of brush tip.

Step 3. Drag in an image to paint.
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6.6 HOW TO DRAW BASIC SHAPES?

With PixelStyle’ s Shape Tool, you are able to draw vector-based image elements to enhance your

photos, create Web elements, icons, logos, post, etc.

Step 1. In the Tools panel, select the Shape Tool.

Step 2. Select a shape, fill color and stroke to add a shape.

A – Click to draw rectangular or square shape.

B – Click to draw ellipse or circle shape.

C – Click to draw star shape.

D – Click to draw polygon shape.

E – Click to draw line shape.

F – Click to draw clockwise spiral shape.

G – Click to select a fill color or gradient color to fill up the shape from the pop-up menu.

H – Set the stroke type for the shape.

I – specify the number of sides for the polygon shape; the number of points for the star shape; the

decay rate of the clockwise spiral shape; corner radius of the rectangular or square shape.

J – Check the checkbox to draw in a new layer.
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Step 3. Drag to draw a shape border.

Step 4. Edit the shape.

Three transform modes for you to quickly adjust your shapes.
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6.7 HOW TO ADD TEXT?

Step 1. Click to select the Type Tool in the Tools panel.

Step 2. In the Options bar, select the type options, such as font, style, size, and color, etc.

A – Choose the font style.

B – Choose the font family.

C – Choose the font size.

D – Choose the font colors.

E – Set typography features including kerning, bold, italic, underline, line-through.

F – Design the text kerning.

G – Design the text deformation.
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Step 3. Enter the characters you want.

TIP:
If you click outside the text box before you begin typing, double-click within the text box to replace the

insertion point within it, and then begin typing.

The text appears in its own layer, which is called a Type layer. Each time you click to create a text

box, a new Type layer is created.

When you've finished typing, click outside the text box.
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6.8 HOW TO SAVE IMAGES?

Save your documents as TIFF, JPEG, PNG, GIF, BMP, PSDB, JPEG  2000, PDF, SVG formats in

PixelStyle Photo Editor.

Step 1. Choose File in the menu bar > Save.
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Step 2. In the Save dialog, type a name for the image.
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Step 3. Choose a file format for saving.

File formats and options available for exporting.

Please note: Save as PixelStyle image (PSDB) if you have not finished editing the document and

want to open non-destructively next time.
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Step 4. Click the “Save” button to save changes to your document.
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7 WORK AREA OVERVIEW

The PixelStyle Photo Editor work area was made easy and handy to enjoyably create graphics and 

edit photos on Mac. This section guides you how to quickly start your workflow and explain what the 

various types of settings are and how they work. This is what it looks like.

1. Menu bar
The Menu bar organizes commands in menus that are carefully arranged by topic and contain drop

down menu.

2. Title bar
The Title bar shows the name and extension of the open document.

3. Document window
The Document window displays the file that you are working on.

4. Tool panel
The Tool panel is the most important panel from which tools used to create and edit images are

selected.
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5. Properties panel
The Properties panel reveals the properties of the selected tool.

6. Histogram/Info panel

The Info panel shows width and height of the selection, as well as the color value, coordinate, radius

and the magnifying color sample beneath a pointer.

   

The Histogram panel enables the view of the tonal distribution of a digital image by all color channel,

luminosity channel, red channel, green channel and blue channel.
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7. Layers/Channels panel

The Layers panel encompasses the operations (add new, duplicate, delete), settings (blend mode,

layer effects) and properties (opacity) of layers.
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The Channels Panel shows the red channel, green channel, blue channel and alpha channel of the

current image.

8. ScreenTip
The ScreenTip gives you tips on quickly completing an action using keyboard shortcuts when working

with a tool.

9. Status panel
The Status panel shows the zoom level, width, height and resolution of the current document.
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7.1 TOOL PANEL

PixelStyle’s various tools are available in the Tool panel. When a tool is selected, its icon will  be

concave with darker color and presented at the top as active tool. 

Please  note: The  Properties  panel  changes  each  time  that  you  switch  tools,  as  every  tool  in

PixelStyle has its own unique settings.
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7.2 PROPERTIES PANEL

The Properties panel reveals the properties of the selected tool. When a tool is selected, its options

are presented in the Properties panel. In this case, the Art Brush tool is chosen and the Properties

panel gives you the options to select brush type, modify its radius, opacity, hardness as well we other

variables.

TO SHOW OR HIDE THE PROPERTIES PANEL:
Choose View > Show Options Bar.
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7.3 LAYERS/CHANNELS PANEL

The Layer panel defines the blend mode, opacity, effects and order of layers. The layers list contains

a list of all your layers. Layers are composited together to form a single image which shows up in

your canvas.The Layer panel is located at the right bottom of the interface.

Also, notice a drop down menu for the blend mode, as well as a slider for the opacity of the selected

layer.
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Each layer in PixelStyle has either two or four channels. In the case of a greyscale image these are

the grey and alpha channels and in the case of a color image these are the red, green, blue and

alpha channels.

The alpha channel determines a layer’s transparency and the primary channels and determine the

layer’s color. PixelStyle typically works on all channels at once, but also allows you to edit the primary

or alpha channels individually.

To show or hide the Layers/Channels panel:
Choose View > Show Layers.
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8 FREQUENTLY ASKED QUESTIONS 

8.1 WHAT IS PIXELSTYLE? WHAT DOES PIXELSTYLE DO?
1.What is PixelStyle?
PixelStyle  Photo Editor  is  an all-in-one photo editor  for  Mac.  As  an  alternative  to  Photoshop,  it

includes all the essential tools you need for basic and professional photo editing.

2. What does PixelStyle do?
(1)Exclusively edit and retouch your photos: resize, transform, adjust color, lighten or darken…

(2)4-Channel editing of images: red, green, blue, alpha channel.

(3)Comprehensive RAW Editing.

(4)Apply dazzling effects to your images: blur, distort, exposure, sharpen…

(5)Create artwork with unique brush tools.

(6)Easily add text anywhere on an image.

(7)Draw and edit smart geometric shapes.

8.2 WHAT ARE THE ADVANTAGES OF PIXELSTYLE PHOTO 

EDITOR? 

1. A set of high-end Filters: lighting, blurs, distortions, tilt-shift, glows...

2.  Professional  Photo  Adjustments:  Adjust  exposure,  hue,  vibrance,  white  balance,  shadows,

highlights, brightness, contrast, blackpoint, clarity and much more.

3. Photo Retouching and Correction: Delete unwanted objects and retouch photos.

4. Best-in-class Photo Noise Reduction: Reduces low light and high ISO noise.

5.  Advanced  Adjustment  Layers:  Correct  and  enhance  photos  with  Levels,  Curves,  Shadows,

Highlights, HSL, White Balance, Black and White ...

6. Comprehensive RAW Editing�  Smart RAW processing engine.

7.  Excellent Text Design Tools: Enjoy a full set of advanced typography features like kerning, bold,

italic, underline, line-through and much more.

8. Automatic saving mechanism: Automatically saves all the changes you make as you work on an

image, which means you never have to save changes manually.
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8.3 WHAT ARE THE DIFFERENCES BETWEEN PIXELSTYLE 

PHOTO EDITOR AND PHOTOSHOP?

1.Easier: Including all the essential tools needed for basic and professional photo editing, PixelStyle

Photo Editor is designed easy for both novice and professionals. It offers tons of easy-to-use tools to

help you create and edit beautiful images. You will find all tools at your hand and start your work in

five to ten minutes after first try.

2.Faster and smoother: Taking full advantages of the latest OS X technologies and unique smart

processing engine,  PixelStyle Photo Editor runs faster and smoother when creating or editing your

document. It occupies less disk space and memory space to keep itself live. 

3.More  inspiring:  PixelStyle  includes  more  than  100  built-in  drawing  brushes  (pencil,  airbrush,

watercolor  brush,  chalk,  charcoal,  neon  pens...)  for  oil  painting,  sketch,  texture  painting,  etc.

Exquisite brushwork with customized settings are awaiting you to bring your creativity into full play.

8.4 IF I IMPORT A TRANSPARENT IMAGE, WILL IT KEEP THE 

TRANSPARENCY?

PixelStyle  uses  gray-and-white  pixel  grid  to  present  transparent  background  and  will  keep  the

transparency of you images. You have options for a transparent background or opaque background

when you are creating a document. By default, PixelStyle uses white color for opaque background.

RELATED TOPICS
Introduction

Quick Start Tutorials

Tools

New Functions

64



8.5 WHAT FILE FORMATS CAN I EXPORT TO?
Save or export your documents as TIFF, JPEG, PNG, GIF, BMP, PSDB, JPEG  2000, PDF, SVG

formats in PixelStyle Photo Editor. Please save as PixelStyle image (PSDB) if you have not finished

editing the document and want to open non-destructively next time.

RELATED TOPICS
Introduction

Quick Start Tutorials

How to Install

Tools
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9 TIPS

9.1 KEYBOARD SHORTCUTS

Action Shortcut
Panels
Show or hide Layers Shift-Command-L
Show or hide Point Information Command-I
Show or hide Option Bar Shift-Command-R
Show or hide Status Bar Command-Forward Slash(/)
Select tools
Move and Align Tool V
Zoom Tool Z
Eyedropper Tool R
Crop Tool C
Text Tool T
Rectangular Marquee Tool M
Elliptical Marquee Tool M
Lasso Tool L
Polygonal Lasso Tool L
Magic Wand Tool W
Brush Tool B
Eraser Tool E
Smudge Tool O
Clone Stamp Tool S
Red Eye Remove Tool R
Burn Tool O
Paint Bucket Tool G
Shape Tool U
Pen Tool P
Path Selection Tool A
Path Eraser Tool E
Node Editor Tool N
Create new
Create new file Command-N
Open file Command-O
Close Window Command-W
Save
Save Command-S
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Save as Shift-Command-S
View images
Zoom in Command-Plus sign(+)
Zoom out Command-Minus sign(-)
Zoom in or out Mouse scroll
Fit image in screen Command-0
Show or hide Rulers Command-R
Show or hide Guides Command-G
Enter or leave full-screen view Command-Control-F
Edit images
Undo last action Command-Z
Redo last action Shift-Command-Z
Fill with color Shift-F5
Resize image Option- Command-I
Crop with 1:1 aspect ration Hold down the Shift key as you drag
Set image boundaries Option- Command-C
Work with selections
Select All Command-A
Select Alpha Shift-Command-A
Deselect Command-D
Inverse Shift-Command-I
Select new area Control
Add to selection Hold down the Shift key as you drag
Subtract from selection Hold down the Option key as you drag
Intersect with selection Hold down the Shift Option as you drag
Inverse intersect with selection Hold down the Shift Control as you drag
Copy Command-C
Cut Command-X
Paste Command-V
Flood all selection Option-click
Preview flood Shift-click
Duplicate Shift-Command-D
Work with layers
Transform Tool Command-T
New layer Shift-Command-N
New shape layer Option-Shift-Command-N
Delete Shift-Command-Delete
Duplicate Command-J
Bring to font Option-Command-Right Bracket(])
Bring forward Command-Right Bracket(])
Send backward Command-Right Bracket([)
Send to back Option-Command-Right Bracket([)
Merge down Command-E
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Merge selected layers Option- Command-E
Copy merged Shift-Command-C
Paint
Increase or decrease brush size Left Bracket ([) or Right Bracket (])
Erase Hold down the Option key as you drag
Draw straight lines Hold down the Shift key as you drag
Draw lines at 45º angle Hold down the Shift Control as you drag
Sample background color Option-click
Draw Shapes
Copy the selected object Hold down the Option key as you drag
Select all Shapes Command-Shift
Select multiple shapes Command-click
Finish Bezier path Double-click
Close Bezier path Command-Control
Print
Print Command-P
Page setup Shift-Command-P
General
Show preferences Command-Comma (,)
Close window Command-W
Close all windows Option-Command-W
Cycle through windows Command-Grave Accent (`) key
Minimize window Command-M
Minimize all windows Option-Command-M
Hide PixelStyle Command-H
Hide others Option-Command-H
Quit PixelStyle Command-Q
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10 CONTACT

Problem unsolved? Never hesitate to contact us if you have any problem, suggestion, or something 

to share with us. We are always happy to hear from you and sincerely at your service!

CONTACT INFORMATION
EffectMatrix Official website: http://www.effectmatrix.com

Technical support: support@effectmatrix.com market@effectmatrix.com 

Effectmatrix forum: http://www.effectmatrix.com/forum
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